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Chapter 730

Tests for Two Survival
Curves Using Cox’s
Proportional Hazards
Model
Introduction
A clinical trial is often employed to test the equality of survival distributions of two treatment groups. Because
survival times are not normally distributed and because some survival times are censored, Cox proportionalhazards regression is often used to analyze the data. The formulation for testing the significance of a Cox
regression coefficient is identical to the standard logrank test. Thus the power and sample size formulas for one
analysis also works for the other.
The Cox Regression model has the added benefit over the exponential model that it does not assume that the
hazard rates are constant, but only that they are proportional. That is, that the hazard ratio remains constant
throughout the experiment, even if the hazard rates vary.
This procedure is documented in Chow, Shao, and Wang (2008) which summarizes the work of Schoenfeld
(1981, 1983). Note that there was an error in Chow, Shao, and Wang (2008) page 179 which caused the sample
size to be doubled. This error has been corrected in this edition.

Technical Details
Cox’s Proportional Hazards Regression
Cox’s proportional hazards regression is widely used for survival data. The regression model is

h (t | z ) = h (t | 0) exp(bz )
where
b is the regression coefficient which is equal to log[h (t | 1) / h (t | 0) = log(HR )]
z is a binary indicator variable of treatment group
t is elapsed time
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h(t|z) is the hazard rate at time t, given covariate z
HR is the hazard ratio h (t | 1) / h (t | 0)
The two-sided, statistical hypothesis testing survival equality is a test of whether b is zero. This hypothesis is
stated as

H 0 : b = 0 versus

Ha : b ≠ 0

Test Statistic
It can be shown that the test of b based on the partial likelihood method of Cox (1972) coincides with the common
logrank test statistic shown next.

Logrank Test
The logrank test statistic is
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Where K is the number of deaths, Yij is the number of subjects at risk just prior to the jth observed event in the ith
group, and Ik is is a binary variable indicating whether the kth even is from group 1 or not.
The distribution of L is approximately normal with mean b P1 P2 dN and unit variance, where
P1 is the proportion of N that is in the control group
P2 is the proportion of N that is in the treatment group
N is the total sample size
N1 is the sample size from the control group, N1 = N(P1)
N2 is the sample size from the treatment group, N2 = N(P2)
Pev1 is probability of the event of interest in the control group
Pev2 is probability of the event of interest in the treatment group
d is the overall probability of an event, d = Pev1P1 + Pev2P2
b is the Cox regression coefficient, b = log(HR)

Power Calculations
The power of the statistical test of b is given by

(

Φ b P1 P2 dN − z1−α / 2

)
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Hazard Rate, Power, or Sample Size. Select Sample Size when you want to calculate the sample size
needed to achieve a given power and alpha level. Select Power when you want to calculate the power.

Test Direction
Alternative Hypothesis
Specify the direction of the test. The "≠" alternative is leads to a two-sided test. Using the "<" or ">" leads to a
one-sided test.
HR stand for the hazard ratio of groups 2 (Treatment) and 1 (Control).
The two-sided test (Ha: HR ≠ 1) is the standard. Only use a one-sided test under special circumstances. If you do
use a one-sided test, be sure that the alternative hypothesis matches the values HR. That is, if you have set HR =
2, and you want to analyze a one-sided test, the Alternative Hypothesis should be 'Ha: HR > 1'.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal survival curves when in fact the curves are different.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when you
reject the null hypothesis of equal survival curves when in fact the curves are equal.
Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means
that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that
represents the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
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Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.
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Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
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R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.

Sample Size - Proportion of Events Observed
Pev1 (Probability of a Control Event)
Enter one or more values for Pev1, the average probability of an event (death) for each individual in the control
group. The number of events in the control group is equal to Pev1 x N1.
Range
0 < Pev1 < 1
Pev2 (Probability of a Treatment Event)
Enter one or more values for Pev2, the average probability of an event (death) for each individual in the control
group. The number of events in the control group is equal to Pev2 x N2.
Range
0 < Pev2 < 1
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Hazard Ratio
HR (Hazard Ratio = h2/h1)
Specify one or more hazard ratios, HR, at which the power is calculated. HR is defined as the treatment hazard
rate (h2) divided by the control hazard rate (h1). HR represents the assumed value at which the power of rejecting
H0 is calculated. When H0 is rejected, you conclude that the hazard ratio is different from one, but not that it is
actually equal to this HR.
The null hypothesis is H0: HR=1. The two-sided alternative hypothesis is Ha: HR≠1. The one-sided alternative
hypotheses are Ha: HR<1 or Ha: HR>1.
Range
If Ha: HR≠1 then the range is 0 < HR. Typical values are from 0.25 to 4.0, except 1.
If Ha: HR < 1 then the range is 0 < HR < 1. Typical values are from 0.25 up to 1.0.
If Ha: HR > 1 then the range is 1 < HR. Typical values are between 1.0 and 4.0.
Press the "Survival Parameter Conversion Tool" button to estimate reasonable values based on median survival
times, hazard rates, or the proportion surviving.
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Example 1 – Finding the Sample Size
A researcher is planning a clinical trial using a parallel, two-group, equal sample allocation design to compare the
survivability of a new treatment with that of the current treatment. The proportion surviving one-year after the
current treatment is 0.50 (h1 = 0.693). The power of the test procedure will be calculated for the case when the
proportion surviving after the new treatment is 0.75 (h2 = 0.288). Hence, HR = 0.288/0.693 = 0.4156.
The probability of an event is 0.50 in the control group and 0.25 in the treatment group. The researcher decides to
use a two-sided test at the 0.05 significance level and a power of either 0.8 or 0.90.
The researchers would like to study the influence of HR on the sample size, so they would like to look at a range
of possible values for 0.3 to 0.7.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Survival Curves Using Cox’s Proportional Hazards Model procedure
window by expanding Survival, then Two Survival Curves, then clicking Test (Inequality), and then clicking
on Tests for Two Survival Curves Using Cox’s Proportional Hazards Model. You may then make the
appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example
Template.
Option

Value

Design Tab
Solve For ............................................................. Sample Size
Alternative Hypothesis ......................................... Ha: HR ≠ 1
Power ................................................................... 0.8 0.9
Alpha .................................................................... 0.05
Group Allocation .................................................. Equal (N1 = N2)
Pev1 (Probability of a Control Event) .................. 0.5
Pev2 (Probability of a Treatment Event).............. 0.25
HR (Hazard Ratio = h2/h1) .................................. 0.3 0.4 0.4156 0.5 0.6 0.7

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results with Ha: HR ≠ 1

Power
0.8016
0.8011
0.8002
0.8009
0.8014
0.8003
0.9025
0.9011
0.9012
0.9009
0.9003
0.9003

Total Control Trtmnt
Sample Sample Sample
Size
Size
Size
N
N1
N2
58
29
29
100
50
50
109
54
55
175
87
88
322
161
161
659
329
330
78
39
39
134
67
67
146
73
73
234
117
117
430
215
215
882
441
441

Prop'n
Control
N1/N
P1
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500

Hazard
Ratio
h2/h1
HR
0.300
0.400
0.416
0.500
0.600
0.700
0.300
0.400
0.416
0.500
0.600
0.700

Control
Prob
Event
Pev1
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500

Trtmnt
Prob
Event
Pev2
0.250
0.250
0.250
0.250
0.250
0.250
0.250
0.250
0.250
0.250
0.250
0.250

Control
Events
E1
14.5
25.0
27.0
43.5
80.5
164.5
19.5
33.5
36.5
58.5
107.5
220.5

Trtmnt
Events
E2
7.3
12.5
13.8
22.0
40.3
82.5
9.8
16.8
18.3
29.3
53.8
110.3

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050

Beta
0.200
0.200
0.200
0.200
0.200
0.200
0.100
0.100
0.100
0.100
0.100
0.100
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Report Definitions
Power is the probability of rejecting a false null hypothesis. Power should be close to one.
N is the total sample size.
N1 and N2 are the sample sizes of the control and treatment groups.
P1 is the proportion of the total sample that is in the control group, group 1.
HR is the hazard ratio: h2/h1.
Pev1 and Pev2 are the probabilities of an event in the control and the treatment groups.
E1 and E2 are the number of events required in the control and the treatment groups.
Alpha is the probability of a type one error: rejecting a true null hypothesis.
Beta is the probability of a type two error: failing to reject a false null hypothesis.
Summary Statements
A two-sided test of whether the hazard ratio is one with an overall sample size of 78 subjects
(of which 39 are in the control group and 78 are in the treatment group) achieves 90% power at
a 0.050 significance level to when the assumed hazard ratio is 0.300. The number of events required to
achieve this power is 29.3. It is anticipated that proportions of subjects having the event
during the study is 0.500 for the control group and 0.250 for the treatment group. These
results assume that the hazard ratio is constant throughout the study and that Cox proportional
hazards regression is used to analyze the data.

These reports show the values of each of the parameters, one scenario per row. We have bolded the row that was
of particular interest to the researchers.

Plots Section

This plot shows the relationship between HR and sample size.
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Example 2 – Validation using Chow et al.
Chow et al. (2008) page 179 present an example of a parallel, two-group, equal sample allocation design to
compare the hazard rates of a new treatment with that of the current treatment using a two-sided, logrank test.
They want to compute the sample size when HR = 2. They further assume that about 80% of the patients will
show the event of interest (infection) during the study. Alpha is set to 0.05 and power is 0.80.
They should have obtained a value of about 41 per group (We have found that the sample size in their example
was doubled).

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Survival Curves Using Cox’s Proportional Hazards Model procedure
window by expanding Survival, then Two Survival Curves, then clicking Test (Inequality), and then clicking
on Tests for Two Survival Curves Using Cox’s Proportional Hazards Model. You may then make the
appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example
Template.
Option

Value

Design Tab
Solve For ............................................................. Sample Size
Alternative Hypothesis ......................................... Ha: HR ≠ 1
Power ................................................................... 0.80
Alpha .................................................................... 0.05
Group Allocation .................................................. Equal (N1 = N2)
Pev1 (Probability of a Control Event) .................. 0.8
Pev2 (Probability of a Treatment Event).............. Pev1
HR (Hazard Ratio = h2/h1) .................................. 2

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results with Ha: HR ≠ 1

Power
0.8015

Total Control Trtmnt
Sample Sample Sample
Size
Size
Size
N
N1
N2
82
41
41

Prop'n
Control
N1/N
P1
0.500

Hazard
Ratio
h2/h1
HR
2.000

Control
Prob
Event
Pev1
0.800

Trtmnt
Prob
Event
Pev2
0.800

Control
Events
E1
32.8

Trtmnt
Events
E2
32.8

Alpha
0.050

Beta
0.200

PASS also calculates the value of N1 = N2 = 41.
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